TIPS & TRICKS SERIES

TIPS & TRICKS
WINDOWS XP HOW TOs

Compiled by

MUHAMMAD AJMAL BEIG NAZ


TIPS & TRICKS

WINDOWS XP HOW TOs

Page | 1

CONTENTS
Table of Contents
WINDOWS XP HOW TOs ________________________________________ 5
How to Install Windows XP Pro? (New Installation) ____________________________________ 5
How to choose special Options during Installation?____________________________________ 5
How to create Disk Partitions? ____________________________________________________ 6
How to choose a File System? _____________________________________________________ 6
Instructions for Windows XP Step-by-Step Installation _________________________________ 6
How to install Driver(s)? _________________________________________________________ 8
How to re-install Windows XP Pro unattended? ______________________________________ 8
How to Repair Install Windows XP Pro? _____________________________________________ 8
How to handle Troubleshooting during Installation? ___________________________________ 9
General Troubleshooting _________________________________________________________ 9
How to Copy File Error during Setup ________________________________________________ 9
How to resolve Computer Hangs or Stops Responding ________________________________ 10
How to Resolve Common Windows Errors? _________________________________________ 11
How to Resolve Fatal Exception Error ______________________________________________ 11
How to Handling an error that’s on the screen _______________________________________ 11
How to Preventing or Reducing Fatal Exception Errors ________________________________ 11
How to remove Error occurs when reading CDs or DVDs _______________________________ 13
How to restore Search Companion Error ___________________________________________ 13
How to resolve Unknown Error 31 ________________________________________________ 13
How to resolve Fast User Switching Error ___________________________________________ 13
How to restore Windows Help and Support Error ____________________________________ 14
How to handle GPF Errors in Windows? ____________________________________________ 14
Step 1 - Reducing Programs that Launch with Windows _______________________________ 14
Step 2 - Increasing System Resources ______________________________________________ 14
Step 3 - Consulting software vendor for known issues_________________________________ 15
How to handle Illegal Operation & Page Fault Errors? _________________________________ 15
Step 1 - Reducing the Number of Software Applications _______________________________ 15
Step 2 - Finding the Application that is Causing Conflicts _______________________________ 16
Step 3 - Eliminating the Errors ____________________________________________________ 16
How to restore Missing or Corrupt files? ___________________________________________ 17
ntoskrnl File __________________________________________________________________ 17
Hal.dll File ____________________________________________________________________ 17
Windows\System32\Config File __________________________________________________ 18
TIPS & TRICKS

WINDOWS XP HOW TOs

Page | 2

Ntldr or Ntdetect.Com Not Found _________________________________________________ 18
How to Improve your Computer Speed and Efficiency _________________________________ 18
Step – 1 Cleanup Applications ____________________________________________________ 18
Step – 2 Update Windows XP and Drivers___________________________________________ 18
Step – 3 Improve Windows XP Performance ________________________________________ 19
How to Improve Windows XP Performance _________________________________________ 19
How to Improve “Folder” Settings: ________________________________________________ 19
How to “Performance” Settings: __________________________________________________ 19
How to “PageFile” Settings: ______________________________________________________ 20
How to Disable Windows' Sounds: ________________________________________________ 20
How to Uninstalling/Deleting unneeded Stuff:_______________________________________ 20
Head over to the following folders and if there is anything in them delete it, if there is not its
OK. _________________________________________________________________________ 20
How to Moving "PrintSpool" to a different partition: _________________________________ 21
Step – 5 Improve Boot Speed_____________________________________________________ 24
How to Disabling Unneeded Programs: ____________________________________________ 24
How to Format a hard drive partition for Windows XP? _______________________________ 24
How to make a hard drive unusable by erasing all data from it?_________________________ 25
How to Reinstall or Repair Internet Explorer 6? ______________________________________ 25
Method 1 – By Reinstalling or Repairing Windows XP _________________________________ 25
Method 2 – By Editing the Registry ________________________________________________ 26
How to Uninstall Internet Explorer 6? ______________________________________________ 26
How to Repair\Return to Previous Installation? ______________________________________ 27
How to handle Error Message in IE6 Installation? ____________________________________ 28
Cause________________________________________________________________________ 28
Resolution____________________________________________________________________ 28
For Windows 95, Windows 98, and Windows Me Edition ______________________________ 28
For Windows NT 4.0 and Windows 2000 ___________________________________________ 29
How to Delete Temporary Internet Files ____________________________________________ 29
How to Install the XP Recovery Console? ___________________________________________ 30
How to delete, largest Sys File (hiberfil) from your PC? ________________________________ 30
How to Increase Windows Folder Cache? ___________________________________________ 31
How to Increase Windows File System Cache? _______________________________________ 31
How to Configure for Auto-Logon? ________________________________________________ 31
How to Poweroff at Shutdown? __________________________________________________ 31
How to Show Hidden Devices in Device Manager? ___________________________________ 32
How to Add Safe Mode to the Boot Menu __________________________________________ 32
How to set the Online Registration as being completed? ______________________________ 32
How to Re-enabling System Restore? ______________________________________________ 32
TIPS & TRICKS

WINDOWS XP HOW TOs

Page | 3

How to Search for Key Words more effectively? _____________________________________ 33
How to keep spam out of the Inbox? (Step-By-Step) __________________________________ 33
Rule #1: Maintain two separate e-mail addresses ____________________________________ 33
Rule #2: Don’t buy from a spam ad ________________________________________________ 34
Rule #3. Don’t even respond to it!_________________________________________________ 34
Rule #4. Turn off cookies ________________________________________________________ 34
Rule #5: Report spam to your ISP _________________________________________________ 34
How to Insert Automatic Product ID? ______________________________________________ 34
How to Burn your own CDs? _____________________________________________________ 34
How to Backup your data? _______________________________________________________ 35
How to scan __________________________________________________________________ 37
Best scan tips _________________________________________________________________ 38
How to choose a digital camera? __________________________________________________ 39



TIPS & TRICKS

WINDOWS XP HOW TOs

Page | 4

WINDOWS XP HOW TOs
How to Install Windows XP Pro? (New Installation)
There are three reasons why you may need to install a new copy of
Windows XP:
1.

Your current operating system doesn’t support an upgrade to
Windows XP Professional.

2.

Your current operating system supports an upgrade to Windows XP
Professional, but you don’t want to keep your existing files and
personalized settings.

3.

Your computer does not have an operating system.

The setup process is similar for new installations and upgrades with a few
notable exceptions. For example, during a new installation, you are able
to configure Special Options, convert your file system, and create a
new partition for the Windows XP installation.
Warning: A new installation deletes all programs or system files
from a previous installation.

How to choose special Options during Installation?
Under Special Options, you have the choice to change Language,
Advanced, and Accessibility settings during the setup process.
Note: If you are in a country that has recently adopted the euro as
its currency, you may have to modify the currency settings to
display monetary amounts correctly.
 Choose the primary language and regions for Windows XP, which
affects the default settings for date, time, currency, numbers,
character sets, and keyboard layout.
 Choose additional language groups and character sets to use with
the programs you are running on Windows XP.
 Advanced Options:






Change the default location of the Setup files.
Store system files in a folder other than the default (Windows)
folder
Copy the installation files from the CD to the hard disk.
Accessibility
Use Narrator or Magnifier during Setup.

Important: Unless you're an advanced user, it's recommended that
you use the default settings.
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How to create Disk Partitions?
You can create partitions to organize information—for example, to back
up data—or to install more than one operating system on your computer.
A hard disk can contain up to four partitions. If you’re performing a new
installation, the appropriate disk partition is selected automatically during
Windows XP Setup unless you click Advanced Options and specify your
own requirements.

How to choose a File System?
During a new installation of Windows XP, you may have to choose which
file system your computer should use. Windows XP Professional supports:


FAT32: An enhanced version of the file allocation table (FAT)
system that is standard on all Windows operating systems starting
with later (32-bit) versions of Windows 95. The FAT32 system can
be used on large hard disks, from 512 megabytes (MB) to 32
gigabytes (GB).



NTFS: The NT file system (NTFS) is used with the Windows NT,
Windows 2000, and Windows XP operating systems. NTFS provides
enhanced reliability, stability, and security, and supports large hard
disks of up to 2 terabytes (TB).

You can convert your file system any time, even after you install Windows
XP, without losing any of your data.
Warning: The conversion to NTFS is one–way only; if you convert
your FAT or FAT32 file system to NTFS you can’t convert your hard
disk back to FAT later.
If you’re not sure which file system to use, keep the one your computer
defaults to during Setup. If you want to change your file system, here are
a few recommendations:


Use FAT32 if your hard disk is smaller than 32 GB.



Use FAT32 if you want to install more than one operating system on
your computer.



Use NTFS if your hard drive is larger than 32 GB and you are
running only one operating system on your computer.



Use NTFS if you want enhanced file security.



Use NTFS if you need better disk compression.

Instructions for Windows XP Step-by-Step Installation
These steps are for a clean install of XP. Read this article for steps on
upgrading your current system to XP.
First, you're going to need to change your BIOS boot order to boot from
CD-ROM. Once you do this, you will then be able to boot your computer
from the Installation CD.
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After changing the boot order in BIOS, save the changes, and then reboot
your computer. Make sure your Installation CD is in your CD-ROM. If it is,
you will be prompted to press your space bar to directly boot from CDROM emulation. Press your space bar as soon as you see this message.
Wait a few minutes while the installation begins to copy the preliminary
setup files to your computer. After this completes you will be ready to
start directing the install process.
You will be asked if you want to perform a new installation, repair an
existing installation, or quit. In this case, you will be performing a new
install. Press the correct key to perform a new installation. Read the
terms of the end user license agreement, and press F8 to agree.
Basically, you need to decide which partition of your hard drive you will
install Windows XP on. You will have the opportunity to create and/or
delete partitions or just allocate the available disk space to one partition.
However, try to keep your partitions within reasonable size.
We recommend using multiple partitions of 4-8GB, preferably on more
than one hard drive. This will help you back up your data and optimize
system performance. Once you have figured out which partition XP will be
installed on it is time to format it.
Choose to format the partition to either FAT32 or NTFS (recommended for
single OS install). You will also see two additional choices to perform a
quick format of each option. Stick with doing a full format of either option
instead. After you have determined which option is right for you, press
the correct key to format the partition.
This would be a good time to take a break and come back in a few
minutes. The setup program will automatically start copying files after the
partition is formatted. From this point on, you're going to see each and
every file name that's being copied over to your hard drive appear in the
lower left corner. As the file names go from A to Z, the installation
completion percentage will increase.
 Choose the region and language.
 Type in your name and organization.
 Enter your product license key.
Name the computer, and enter an Admin password. Do not forget to write
down your Administrator password. After the installation is complete, it
would be extremely wise to create a password restore disk in the event
you forget your Administrator password someday.
Choose your network settings. Choose workgroup or domain name.
Register this copy of Windows XP if you have installed all the current
hardware on your machine. Otherwise, wait until you have finished
installing any additional hardware so you do not have to activate your
copy of XP again. Add users that will sign on to this computer. Log in, and
update drivers.
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How to install Driver(s)?
XP found drivers for all of the hardware in our test machines, with the
exception of a wireless network adapter that was added. Update all
drivers that had updates available for download.
It takes about 30 minutes to perform this installation. After that, you will
be a few personalized settings away from getting started on your XPexperience.

How to re-install Windows XP Pro unattended?
If you need to reinstall Windows XP and want to keep all your current
installed applications and settings, follow these steps:
1. Start Windows XP
2. Go to the location of your source files
3. Run WINNT32 /unattend
You have needed to do this to repair something that had gotten corrupted
and didn't want to do a clean install.

How to Repair Install Windows XP Pro?
If XP is corrupted to the point where none of the previous solutions get it
to boot, you can do a Repair Install that might work as well as keep the
current settings. Make sure you have your valid WindowsXP key. The
whole process takes about half an hour depending on your computer. If
you are being prompted for the administrator's password, you need to
choose the 2nd repair option, not the first.
1.
2.
3.
4.
5.
6.
7.
8.
9.
10.
11.
12.
13.
14.
15.
16.
17.

Insert and boot from your Windows XP CD.
At the second R=Repair option, press the “R” key.
This will start the repair.
Press F8 for “I Agree at the Licensing Agreement”.
Press “R” when the directory where WindowsXP is installed is
shown. Typically this is C:\WINDOWS
It will then check the C: drive and start copying files.
It will automatically reboot when needed. Keep the CD in the drive.
You will then see the graphic part of the repair that is like during a
normal install of XP (Collecting Information, Dynamic Update,
Preparing Installation, Installing Windows, Finalizing Installation)
When prompted, click on the “Next” button.
When prompted, enter your XP key.
Normally you will want to keep the same Workgroup or Domain name.
The computer will reboot.
Then you will have the same screens as a normal XP Install.
Activate if you want (usually a good idea)
Register if you want (but not necessary)
Finish.
At this point, you should be able to log in with any existing accounts.
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How to handle Troubleshooting during Installation?
The following troubleshooting steps that you can use if you have problems
when trying to upgrade to Windows XP from Microsoft Windows 98, from
Microsoft Windows 98 Second Edition. The information applies to both
Microsoft Windows XP Home and Professional Edition.
WARNING: This article contains steps that may involve changing
your Basic Input/Output System (BIOS) or Complementary
Metal Oxide Semiconductor (CMOS) settings or that may require
you to make physical changes to your computer hardware. Incorrect
changes to the BIOS of your computer can result in serious
problems. Microsoft cannot guarantee that problems that result
from changes to your BIOS can be resolved. Change your BIOS
settings at your own risk. If you need assistance with any of these
steps, contact your hardware manufacturer and note that making
either hardware or BIOS changes to your computer may invalidate
your warranty. If you do not want to make hardware changes to
your computer, you can take your computer to a repair center.

General Troubleshooting
If you have problems while you run Setup, clean boot your computer.
Clean-boot troubleshooting refers to methods that you can use to reduce
behaviors that may occur because of your computer's environment. Many
behaviors that occur when you run Windows or programs occur because
there are conflicting drivers, terminate-and-stay-resident programs
(TSRs), and other settings that start when your computer starts.
Note: You may need to contact the software manufacturer to
determine if the software is compatible with Windows XP or to
obtain a version of the software that is compatible with Windows
XP.

How to Copy File Error during Setup
When you try to install Windows XP, you may receive the following
message, where file_name is the file that Setup cannot copy:
Setup cannot copy the file file_name. Press X to retry, Y to abort.
This behavior can occur for any of the following reasons:
1.

Your Windows XP CD-ROM is scratched, smudged, or dirty. Clean
the Windows XP CD-ROM with a soft cloth, insert it into the CDROM drive again, and then click OK.

2.

Your CD-ROM drive is not working correctly or the CD-ROM might
be vibrating too much for the laser to accurately read the data.

3.

If you are using multiple CD-ROM drives, your computer may be
trying to locate files on the wrong drive. If your hardware has a
feature to disable CD-ROM drives that are not being used, disable
the CD-ROM drives that you are not using.
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4.

Your computer is over-clocked. Because over-clocking is very
memory-intensive, decoding errors may occur when you extract
files from your Windows XP CD-ROM.

5.

Try to use the default clock timings for your motherboard and
processor. For more information about how to do this, consult
your hardware documentation.

6.

Your computer has damaged or mismatched random access
memory (RAM) or cache memory. For example, you might be
using a combination of extended data out (EDO) and non-EDO
RAM, or different RAM speeds.

7.

Your computer has Ultra direct memory access (DMA) turned on in
the CMOS settings, and the data is moving too quickly.

8.

Change from DMA mode to Processor Input/Output (PIO) mode to
lower your data transfer rate. If this does not resolve the problem,
lower your PIO mode settings. The higher your PIO mode settings
are, the faster your data transfer is.

9.

You are using a third-party memory manager.

10. There is a virus on your computer.
If you continue to receive this error message, copy the i386 folder from
the CD-ROM drive to your local hard disk, and then try to run Setup from
your hard disk.

How to resolve Computer Hangs or Stops Responding
When you try to upgrade to Windows XP, your computer may stop
responding (hang) and a black screen may be displayed. This behavior
may be caused by either hardware or software that is incompatible with
Windows XP operating system. To work around this behavior follow these
steps:
1. Wait 10 to 15 minutes on this screen to make sure that the
computer does not continue with the Setup procedure.
2. Restart the computer to see if it hangs again at the same place
during Setup. Occasionally, Setup may go further with the Setup
procedure than the last time that Setup stopped responding. If this
occurs, try to restart your computer several times so that Setup
may finish.
3. Restart the computer and choose the option to Cancel Windows
XP Setup to revert back to Windows 98. If the option to Cancel
Windows XP Setup is not an option when you restart your
computer, view step 5.
4. After you revert back to Windows 98, uninstall any antivirus
programs, any boot manager programs (such as GoBack), and then
perform a clean boot of your computer. To perform a clean boot,
view the article for you operating system that is references earlier
in this article.
5. If the upgrade hangs again, there may be a hardware
incompatibility issue. You can try to disable ACPI functionality.
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When your computer restarts, you receive an option to press F6 to
add third-party small computer system interface (SCSI) drivers. On
this screen, press F7. Note that no visual notification is displayed.
6. If Setup continues to hang, disable unnecessary hardware. Remove
any USB devices, remove or disable network cards, sound cards,
and serial cards, and then restart Setup.
7. If you continue to receive this error message, you may need to
flash the BIOS on the motherboard. Please refer to the
manufacturer of your computer or to the motherboard Web site for
information about how to do this.
8. If a BIOS update does not resolve the issue, or if you are unable to
obtain an updated BIOS version for the computer, you may want to
install Windows XP with a Standard PC Hardware Abstraction Layer
(HAL). To do so, press F7 when you are prompted to press F6
during Windows XP Setup. Specifically, you are prompted to press
F6 after Setup restarts the computer for the first time.

How to Resolve Common Windows Errors?
These information (applies to Windows 95, 98, Me, and XP) explains fatal
exception errors, how to eliminate them, and how to reduce the likelihood
that the errors will occur again.

How to Resolve Fatal Exception Error
When a computer's processor is unable to perform an operation, Windows
sends an exception message to the software program that was using the
processor. If the software program does not handle the exception, a fatal
exception error occurs. Typical fatal exception errors appear as:


A Fatal Exception 06 has occurred at 0028:00000026



This Program Has Caused a Fatal Exception 0D at 00457:000040B1
and Will Be Terminated

How to Handling an error that’s on the screen
1. If a CD or DVD was recently removed from a drive, replace the disc,
wait ten seconds, and press the SPACE key.
2. Press ENTER to try to clear the error message. The program that
was running should close automatically, and the system will try to
return to the main screen.
3. Save work if the error message disappears.
4. Click Start, Shut Down, Restart, and OK. If the computer does
not restart after doing this, wait one minute and press the
computer's POWER button for five seconds until it shuts off.

How to Preventing or Reducing Fatal Exception Errors
When a fatal exception error appears while working from a software
program, perform the following steps, in order, until the error is resolved:
1. Temporarily turn off virus scanning. If an error consistently occurs
when an operation is performed, like saving a file, turn the virus
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scanning software off while performing the operation. Click Start,
(All) Programs, and then click the name of the virus scanning
software.
2. Increase the computer's system resources, such as memory, hard
drive space, and processing power.
3. Uninstall and reinstall the program that was being used when the
error occurred:
a. In Windows XP, click Start, and then Control Panel. In
Windows 95, 98, and Me, click Start, Settings, and then
Control Panel.
b. Double-click the Add/Remove Programs icon.
c. Select the desired program from the list and click the
Change/Remove or Add/Remove button.
d. Click OK (Windows 98, Me) or Close (Windows XP) and
restart the computer when finished. Answer any questions if
any pop-up screens appear when uninstalling.
e. Reinstall the software program from its installation disks or
discs. If the software program came with the Pavilion
computer, then reinstall it by using Application Recovery.
4. Verify that Windows is managing the virtual memory:
a. In Windows XP, click Start, and then Control Panel. In
Windows 95, 98, and Me, click Start, Settings, and then
Control Panel.
b. In Windows XP, click Performance and Maintenance, and
then double-click the System icon. In Windows 95, 98, and
Me, double-click the System icon.
c. In Windows XP, click the Advanced tab, click the Settings
button under Performance. In Windows 95, 98, and Me, click
the Performance tab.
d. In Windows XP, click the Advanced tab and then click the
Change button. In Windows 95, 98, and Me, click Virtual
Memory.
e. In Windows XP, select System managed Size if it is not
already selected and click OK. In Windows 95, 98, and Me,
select Let Windows Manage My Virtual Memory if it is not
already selected, and click OK.
f. Close all open windows and restart the computer. Test for
errors.
5. Prevent other programs that are not useful from starting up with
Windows.
6. Perform a virus scan with updated virus definitions.
7. Check the software manufacturer's Web site for updates or
compatibility information.
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8. Back up important files and perform a full system recovery. This
should be done as a last resort because you will need to manually
reinstall any software that did not come with the system.

How to remove Error occurs when reading CDs or DVDs
If a CD or DVD was recently removed from a drive, replace the disc, wait
ten seconds, and press the SPACE key. Make sure the compact disc is
clean and unscratched. A dirty or scratched CD can cause Fatal Exception
errors. If the errors persist in Windows 98 and Me, turn off the CD-ROM
drive cache. This may make the drive more reliable but can reduce the
drive's performance. Turn off the CD-ROM drive cache by following these
steps:
1.
2.
3.
4.

Click Start, Settings, and Control Panel.
In the Control Panel window, double-click the System icon.
Click the Performance tab, and click File System.
Click the CD-ROM tab. In the Optimize Access Pattern For list,
click No Read-Ahead.
5. Drag the Supplemental Cache Size slider to the Small setting,
and click OK.

How to restore Search Companion Error
When doing a file search, if you get the error A File That Is Required to
Run Search Companion Cannot Be Found, follow these steps:
1.
2.
3.
4.
5.
6.

Log on as an Administrator
Click Start
Select Run
Enter in the command - %systemroot%\inf
Right-click the Srchasst.inf file
Click Install

How to resolve Unknown Error 31
Although you can log in locally without a password, by default,
WindowsXP Pro does not allow network users to access the computer
without a password. Typically you will receive an Unknown error 31 if
this is the case. To change this setting, do the following:
1. Run gpedit.msc
2. Go to Computer Configuration / Windows Settings /
Security Settings / Local Policies / Security Options
3. Double click on Accounts: Limit local account use of blank
passwords to console login only
4. Disable this option

How to resolve Fast User Switching Error
If you are getting an error that: A recently installed program has
disabled the Welcome screen and Fast User Switching with a
reference to CSGina.DLL, follow these steps to resolve the problem:
1. Start Regedit
2. HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows
NT\CurrentVersion\Winlogon
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3. Delete the key GinaDLL

How to restore Windows Help and Support Error
If you get an error Windows cannot find HELPCTR.EXE, it may be that a
registry entry has been corrupted. To resolve, follow these steps:
1. Start Regedit and go to
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVers
ion\App Paths\HELPCTR.EXE
2. If the key isn't there, right click and create a new key HelpCtr.exe
3. It should have a value of
C:\WINDOWS\PCHealth\HelpCtr\Binaries\HelpCtr.exe
4. Reboot

How to handle GPF Errors in Windows?
This information (applies to Windows 95, 98, Me, and XP) explains fatal
exception errors, how to eliminate them, and how to reduce the likelihood
that the errors will occur again. A GPF is a type of Fatal Exception error
message that Windows was unable to fully identify. These usually relate
to memory violations. While software runs, it uses memory to perform its
work. Windows compatible programs need to reserve memory before
working. If programs do not reserve memory in the proper manner, they
can potentially overwrite other program's reserved memory space. When
this happens, any number of very bad things can happen, including loss
of important data that is stored on the hard drive. A General Protection
Fault or other memory errors occur to prevent these catastrophes from
happening.

Step 1 - Reducing Programs that Launch with Windows
The following steps will prevent all programs from launching when
Windows starts. These steps are for troubleshooting purposes only and
will prevent other programs, like virus scanners, from loading.
1.
2.
3.
4.
5.

Click Start, then Run.
In the Open field, type: msconfig
Click OK. The System Configuration Utility window appears.
Click the General tab if it is not already selected.
Select Selective startup and remove the checkmarks from Load
startup group items and Load static VxDs (not in Windows 98).
6. Click OK and restart the computer.
7. After the computer has restarted, test the computer to see if the
Illegal Operation error messages still continue.
o

If the software program is still showing the error messages,
continue down to Step 2.

o

If the program is no longer showing error messages, another
software program was interfering and will need to be disabled
or removed.

Step 2 - Increasing System Resources
The system has to work harder as memory and hard drive space is
diminished. Try to increase system resources by follow these steps:
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1.
2.
3.
4.

Right click My Computer icon.
Click Properties (usually the last item of the menu)
Open Performance tab in Windows 98
In Windows XP Click Advanced tab and under Performance click
Settings to open new window
5. Make necessary changes and click OK

Step 3 - Consulting software vendor for known issues
If the GPF error occurs with one particular software program, consult the
software vendor's Web site for more information. Look for a support site
when browsing the company's main page, then look for FAQ, Known
Issues, or Support Documentation Web pages. To find the software's
vendor, open the software program that is causing the errors and click
Help, then About.

How to handle Illegal Operation & Page Fault Errors?
When the processor is unable to perform a task required by a software
application, Windows responds by displaying an illegal operation error
message. Windows closes the software application or sends the software
application an exception error message.
Note: An invalid page fault message normally appears within the
text of an illegal operation error message.
This information (applies to Windows 95, 98, Me, and XP) explains how to
eliminate illegal operation and invalid page fault error messages. The
following examples show types of illegal operation error messages:


(Name of software application): This program has performed an
illegal operation and will be shut down



Illegal operation caused by (name of the software application) in
module unknown



An Invalid Page fault occurred in module unknown

Step 1 - Reducing the Number of Software Applications
The following steps will reduce the number of applications and prevent
unwanted software applications from opening when Windows starts:
1.
2.
3.
4.
5.

Click Start and then click Run.
In the Open field, type: msconfig
Click OK. The System Configuration Utility window appears.
Click the General tab and select Selective Startup.
Remove the checkmarks from Load startup group items and
Load static VxDs. Load Static VxDs is not available in Windows
98.
6. Click OK and then restart the computer.
7. After the computer has restarted, try using the software application
that caused the error to see if the Illegal operation error messages
continue.
8. If the Illegal operation error messages continue, go to "Step 2:
Finding the software application."
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Note: If the Illegal operation error messages are not present,
another software application was causing the error. Disable or
remove the software application that was causing the error.

Step 2 - Finding the Application that is Causing Conflicts
If the computer displays an Illegal operation or Invalid page fault error
message, close the software application that is currently in use. Find the
conflicting software application by using the following steps:
1. Create a list of all other software applications that were open when
the error message occurred. You can use this information in the
future to find the software application that is causing the error
messages.
2. Turn the computer off.
3. Wait one minute and turn the computer on again.
4. Do not open the first software item on the list. Draw a line through
the first software application on the list to note which software
application is not open. Software applications that remain open are
the software applications that can potentially cause software
conflicts.
5. Open all other software applications on the list.
6. Open the software application that caused the error message.
7. If the software application causes an error message again, repeat
these steps, opening one less software application each time.
Repeat these steps until the software application that is causing the
error message is identified.
Note: If closing anti-virus software solves the problem, disable the
anti-virus software whenever working with the software application
that caused the error message.
Warning: Do not open new software applications, new document
and spreadsheets, or use e-mail with the anti-virus software
disabled.

Step 3 - Eliminating the Errors
After the conflicting software application is found, perform the following
steps, in order, until the issue is resolved:
1. Change how the software application is used. For example, if the
error occurs when a certain setting in the software application is
used, try using a different setting. If the error occurs when printing
with a certain printer driver, try setting the print driver so that it
prints directly to the printer.
2. Uninstall, and then reinstall the software application that is causing
the main errors.
a. In Windows 95, 98, and Me, click Start, click Settings, and
then click Control Panel. In Windows XP, click Start, and
then click Control Panel.
b. Double-click the Add/Remove Programs icon. The
Add/Remove Programs window appears.
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c. Select the software application that is causing the lockups and
click Add/Remove or click Change/Remove.
d. Read and respond to windows that open. Click OK or click
Yes to windows that open and ask for the removal of a
shared file.
e. Click OK or Close in the Add/Remove Programs window.
f. Restart the computer.
g. Reinstall each software application, following the software
manufacturer's instructions.
h. Open the software applications. If the error message occurs
again, continue to the next item.
3. Check the software manufacturer's Web site for a resolution or a
software patch.
Uninstall any software applications that conflict with the software
application that caused the error message. If uninstalling the software
application is not an acceptable option, close all other software
applications while using the software application that caused the error
message.

How to restore Missing or Corrupt files?
ntoskrnl File
If you get an error that NTOSKRNL not found:
1. Insert and boot from your WindowsXP CD.
2. At the first R=Repair option, press the R key
3. Press the number that corresponds to the correct location for the
installation of Windows you want to repair.
Typically this will be #1
4. Change to the drive that has the CD ROM (CD i386)
5. Expand ntkrnlmp.ex_ C:\Windows\System32\ntoskrnl.exe
6. If WindowsXP is installed in a different location, just make the
necessary change to C:\Windows
7. Take out the CD ROM and type exit

Hal.dll File
If you get an error regarding a missing or corrupt hal.dll file, it might
simply be the BOOT.INI file on the root of the C: drive that is
misconfigured.
1. Insert and boot from your WindowsXP CD.
2. At the first R=Repair option, press the R key
3. Press the number that corresponds to the correct location for the
installation of Windows you want to repair.
Typically this will be #1
4. Type bootcfg /list to show the current entries in the BOOT.INI file
5. Type bootcfg /rebuild to repair it
6. Take out the CD ROM and type exit
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Windows\System32\Config File
If you get the error:
Windows could not start because the following files is missing or corrupt
\WINDOWS\SYSTEM32\CONFIG\SYSTEM or
\WINDOWS\SYSTEM32\CONFIG\SOFTWARE
1. Insert and boot from your WindowsXP CD.
2. At the first R=Repair option, press the R key
3. Press the number that corresponds to the correct location for the
installation of Windows you want to repair.
Typically this will be #1
4. Enter in the administrator password when requested
5. cd \windows\system32\config
6. Depending on which section was corrupted:
ren software software.bad or ren system system.bad
7. Depending on which section was corrupted
copy \windows\repair\system
copy \windows\repair\software
8. Take out the CD ROM and type exit

Ntldr or Ntdetect.Com Not Found
If you have FAT32 partitions, it is much simpler than with NTFS.
Just boot with a Win98 floppy and copy the NTLDR or NTDETECT.COM
files from the i386 directory to the root of the C:\ drive. For NTFS, follow
these steps:
1. Insert and boot from your WindowsXP CD.
2. At the first R=Repair option, press the R key
3. Press the number that corresponds to the correct location for the
installation of Windows you want to repair. Typically this will be #1
4. Enter in the administrator password when requested
5. Enter in the following commands (X: is replaced by the actual drive
letter that is assigned to the CD ROM drive.
COPY X:\i386\NTLDR C\:
COPY X:\i386\NTDETECT.COM C:\
6. Take out the CD ROM and type exit

How to Improve your Computer Speed and Efficiency
Step – 1 Cleanup Applications
Keep your computer completely clean and securely delete unwanted files
by using Windows Disk Cleanup (Start > All Programs > Accessories >
System Tools) or use any high rated third party program. By maintaining
your PC periodically, Windows and all off you programs will work faster
and run more stable, even during Start up and shutdown of a program.
We suggest you run these cleanup programs once a week to maintain
your pc clean and running smooth.

Step – 2 Update Windows XP and Drivers
Microsoft releases security patches and enhancements for Windows XP on
regular basis, so make it a habit to check for updates every week.
Make sure you update your Windows to the latest patches.
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Connect to the internet and then click Start > All Programs >
Windows Update (look all the way on top). Shortly after clicking
"Windows Update", your web browser will take you to Microsoft's Update
site; here you are going to be offered to selections, "Express" and
"Custom" select "Custom". Then click on all the available updates for
your computer and select “Install Updates".

Step – 3 Improve Windows XP Performance
How to Improve Windows XP Performance
 Verify protected Windows files:
Click Start > Run (Win key + R) and type CMD then press enter.
You will get a black screen come up where you can type in. Type
SFC /SCANNOW then press enter to verify that All protected
Windows files are intact and in their original versions.
 Start programs Faster with “Prefetch” Tweak
You can speed up almost any program's loading time slightly by
telling it to prefetch. Right click on the programs icon, choose,
”Properties”. Inside the "Target", add this line at the end
/prefetch:1; for example:
"C:\Program Files\Webshots\Launcher.exe" /prefetch:1

How to Improve “Folder” Settings:
To improve your system performance, follow these steps:
1.
2.
3.
4.

Open "My Computer"
Click "Tools" and select "Folder Options"
Select the View tab
Uncheck/Check the Following:
Uncheck "Automatically search for network folders and printers"
Check "Launch folder windows in a separate process"
Check "Do not cache thumbnails"

How to “Performance” Settings:
Windows XP is candy to your eyes and it really has an appealing view, but
then again these features really seem to hog up many system resources
and have a slight affect on system performance and response time. Follow
these steps:
Click Start >Settings >Control Panel >System >Advanced tab, and
then in the Performance tab select Settings, choose Adjust for best
performance. Also perform following adjustments by Right clicking on
desktop >properties:



Background tab > no background image
Screen saver tab: - no screen saver
- Power options > power schemes > switch off monitor – never
- Power options > power schemes > switch off hard drives – never
- Power options > power schemes > switch off – never
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- Power options > power schemes > standby – never
- Power options > hibernation > deactivate hibernation

How to “PageFile” Settings:
If you have a single or two hard drives and more than one partition, this
tweak is for you. You can increase windows XP performance by allocating
the pagefile to a separate drive or partition. Follow these steps:
Click Start >Settings >Control Panel >System >Advanced tab, and
then in the Performance tab, select Settings >Advanced tab. Under
Virtual memory, click Change.
Now look under Drive [Volume Label] and if your page file is currently
on the drive/volume where your OS is at (usually C:\), you can move it to
another free drive or partition. Let’s assume, your page file is currently
managed on C:\, the only way to achieve optimal pagefile performance is
to place it away from the partition/drive where the OS is at. To do this,
follow these steps:
1. Click on C: write down the Maximum size (MB), select No paging
file, and click Set.
2. Next, choose a partition where you want to manage the pagefile
and select Custom size: and set the Initial size (MB) and
Maximum size (MB) to something realistic like 1024 then press
Set and restart your computer.

How to Disable Windows' Sounds:
By Default Windows XP has sounds assigned to many actions on your PC.
If you disable these, you could be sure no PC performance is lost due to
sounds. Click Start >Settings >Control Panel >Sounds and Audio
Devices, and then click the Sounds tab, Under Sound Scheme >select
No Sounds.

How to Uninstalling/Deleting unneeded Stuff:
Start >Settings >Control Panel >Add or Remove Programs
>Add/Remove Windows Components, Uncheck the following:






Indexing Service
MSN Explorer
Windows Messenger
Outlook Express (If you don’t use it)
Internet Explorer (If you use Opera, Firefox or any other)

Head over to the following folders and if there is
anything in them delete it, if there is not its OK.






C:\Windows\SoftwareDistribution\Download
C:\windows\system32\dllcache\
C:\Documents and Settings\your_name_here\Local Settings\History
C:\Documents and Settings\your_name_here\Local
Settings\Temporary Internet Files
C:\Program Files\LimeWire\.NetworkShare
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C:\Documents and
Settings\your_name_here\.limewire\.NetworkShare\Incomplete
C:\WINDOWS\Offline Web Pages
C:\WINDOWS\Temp
C:\Documents and Settings\your_name_here\UserData
C:\WINDOWS\pchealth\helpctr\OfflineCache
C:\WINDOWS\system32\config\systemprofile\Cookies
C:\Program Files\CachemanXP\Backups
C:\Documents and Settings\your_name_here\Cookies\index.dat
C:\WINDOWS\pchealth\helpctr\OfflineCache\index.dat
C:\Documents and Settings\your_name_here\UserData\index.dat

How to Moving "PrintSpool" to a different partition:
First, create a folder called PrintSpool in any drive or partition; windows
isn’t using. Go to "Start", "Settings", "Control Panel", "Printer and Faxes",
click "File", "Server Properties", then click on the "Advanced" tab , where
it says "Spool Folder:" enter the exact location where the folder you have
created. Example: D:/PrintSpool (Default Printer Spool Folder:
C:\WINDOWS\System32\spool\PRINTERS)

Step – 4 Disable XP Services
Services are programs that Windows has running in the background to
keep certain parts of the system running, some are crucial for the
system while other are just useless and are hogging up precious RAM.
To disable certain useless services, first start by clicking Start >Run, and
typing: Services.msc. To edit a service right click it, select properties
and edit the startup type. Disable the following services may improve
performance on most systems:
1. Alerter
Sends alert messages to specified users that are connected to the
server computer.
2. Application Management
Allows software to tap directly into the Add/Remove Programs
feature via the Windows Installer technology.
3. Background Intelligent Transfer Service
This service is used by programs (such as Windows AutoUpdate) to
download files by using spare bandwidth.
4. Clipbook
It permits you to cut and paste text and graphics over the network.
5. Computer Browser
Maintains an updated list of computers on the network and supplies
this list to computers designated as browsers.
6. Distributed Link Tracking Client
Maintains links between NTFS files within a computer or across
computers in a network domain.
7. Error Reporting
Allows applications to send error reports to Microsoft in the event of
an application fault.
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8. Fast User Switching
Windows XP allows users to switch quickly between accounts,
without requiring them to log off.
9. Help and Support
Allows the XP Built-in Help and Support Center to run.
10. IMAPI CD-Burning COM Service
You don't need this if you have other software to create CDs.
11. Indexing Service
Indexes contents and properties of files on local and remote
computers; provides rapid access to files through flexible querying
language.
12. IPSEC Services
Manages IP security policy and starts the ISAKMP/Oakley (IKE) and
the IP security driver. If you are not on a domain, you likely don't
need this running.
13. Messenger
Transmits net send and Alerter service messages between clients
and servers. This is how many pop-up windows start appearing on
your desktop.
14. Net Logon
Supports pass-through authentication of account logon events for
computers in a domain. If you are not on a domain, you don't need
this running.
15. Network DDE
Provides network transport and security for Dynamic Data Exchange
(DDE) for programs running on the same computer or on different
computers.
16. NT LM Security Support Provider
Provides security to remote procedure call (RPC) programs that use
transports other than named pipes.
17. Performance Logs and Alerts
Collects performance data from local or remote computers based on
preconfigured schedule parameters then writes the data to a log or
triggers an alert. If you don't need to monitor your performance
logs, then you don't need this service.
18. Portable Media Serial Number
Retrieves the serial number of any portable music player connected
to your computer.
19. QOS RSVP
Provides network signaling and local traffic control setup
functionality for QoS-aware programs and control applets.
20. Remote Desktop Help Session Manager
Manages and controls Remote Assistance. If you are not using
Remote Desktop you don't need this service.
21. Remote Registry Service
Enables remote users to modify registry settings on this computer.
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22. Routing & Remote Access
Offers routing services to businesses in local area and wide area
network environments. Allows dial-in access.
23. Secondary Logon
Enables starting processes under alternate credentials. This is what
allows you to run an application as another user.
24. Smart Card
Manages access to smart cards read by this computer.
25. Smart Card Helper
Enables support for legacy non-plug and play smart-card readers
used by this computer.
26. SSDP Discovery Service
Enables discovery of UPnP devices on your home network.
27. TCP/IP NetBIOS Helper
Enables support for NetBIOS over TCP/IP (NetBT) service and
NetBIOS name resolution. This should not be needed in today's
network environment.
28. Telnet
Enables a remote user to log on to this computer and run programs,
and supports various TCP/IP Telnet clients.
29. Uninterruptible Power Supply Service
Manages an uninterruptible power supply (UPS) connected to the
computer.
30. Universal Plug and Play Device Host
Provides support to host Universal Plug and Play devices
31. Upload Manager
Manages synchronous and asynchronous file transfers between
clients and servers on the network.
32. Volume Shadow Copy Service
Manages and implements Volume Shadow Copies used for backup
and other purposes.
33. Web Client
Enables Windows-based programs to create, access, and modify
non-local files across the Internet.
34. Windows Time
Maintains date and time synchronization on all clients and servers in
the network.
35. Wireless Zero Configuration
Provides automatic configuration for the 802.11 adapters
36. WMI Performance Adapter
Provides performance library information from WMI HiPerf
providers.
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Step – 5 Improve Boot Speed
How to Disabling Unneeded Programs:
Go to Start >Run, and type in: MSCONFIG, it will bring up System
Configuration Utility, click on the Services tab, select Hide All
Microsoft Services. Deselect any programs you find unnecessary then
select the Startup tab and do the same. When finished click Apply and
restart your computer.

How to BIOS Tweaking:
In the BIOS, disable "Floppy Drive Seek", and select the disk on which
your OS is located as your first boot device

How to Removing Visual Effects:
1. First, disable visual effects through Performance Options as
mentioned earlier in this guide.
2. Remove desktop wallpaper
Remove any unneeded fonts, to do this go to Control Panel >Fonts,
then just select the fonts you don’t need and delete them, or save them
to a folder.

How to Format for Windows XP?
1. If you want to save any of the data on the disk, back it up by
copying it to a CD or another hard drive. Formatting will destroy ALL
of the data on the disk.
2. Use the Windows XP CD-ROM to boot the computer.
3. Select the "Recovery Console" option.
4. At the prompt, type FORMAT C:
5. You may be prompted with something like "Are you sure?", type Y
for YES and hit Enter
6. Give the process some time to complete. Install your operating
system of choice, or use the blank disk for another purpose.

How to Format a hard drive partition for Windows XP?
1. Back up all of the files that you need, probably onto CDs or an
external hard drive.
2. Navigate to "My Computer" on the start menu, and right click on
the drive that you want to delete the files from.
3. On the drop down list, select "Format..."
4. Your computer's drop down menu will probably differ. Set the file
system to NTFS, which is short for NT File System. This is the new
formatting standard in Windows, and can handle drive sizes of up to
six terabytes (6,000 gigabytes).
5. This is the prompt for formatting a drive. Set the Allocation unit size
to the maximum possible, which for big drives should be 4096
bytes.
6. Choose "Start" and continue past the warning that your hard drive
will be erased.
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7. Wait for a while, depending on the size of the drive. When it is
done, the hard drive/partition will be devoid of files.
Note: You cannot format local disk C:\ because your operating
system is directly running from it and it’s being used.

How to make a hard drive unusable by erasing all data
from it?
Keeping in view the security reasons, you must totally erase data from
your hard disk before disposing it off. Here is how you can do it:
1. Take out the hard drive from the casing by removing all data cables
attached to it.
2. Expose it to a very strong magnetic field, using a device with
electromagnets called a degausser. This will destroy the drive and
make it completely impossible to reuse or recover data from.
Note: Common household magnets are usually not strong enough
to fully erase a hard drive.

How to Reinstall or Repair Internet Explorer 6?
The following information describes how to reinstall or repair Internet
Explorer 6 and Outlook Express 6 in Windows XP. You must do this if you
are having problems with Internet Explorer or Outlook Express because of
damaged files or missing registration information.
Warning: All the information provided below are about modifying
the registry. Before you modify the registry, make sure to back it
up and make sure that you understand how to restore the registry
if a problem occurs. If you use Registry Editor incorrectly, you may
cause serious problems that may require you to reinstall your
operating system. For more information about how to back up,
restore, and edit the registry, read the section in this book entitled
“Windows XP Registry”.
Note: After you follow the procedures provided here, you must
reinstall any updates to Windows XP again.
To resolve the issues, use either of the following methods while you are
logged on as an administrator.

Method 1 – By Reinstalling or Repairing Windows XP
To repair or reinstall Internet Explorer and Outlook Express in Windows
XP, complete the following procedure while you are logged on as an
administrator:
1. Use the System File Checker tool to scan all of the protected files on
your computer:
a. Click Start, and then click Run.
b. In the Open box, type sfc /scannow, and then click OK.
(Note: You may be prompted to insert the Windows XP
installation CD-ROM.)
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2. Test to determine if the issue is resolved. If the issue is resolved, skip
the remaining steps. If the issue is not resolved, continue to the next
step.
3. Complete an in-place upgrade of Windows XP, a repair of Windows XP,
or reinstall Windows XP.

Method 2 – By Editing the Registry
1. While you are logged on as an administrator, click Start, and then
click Run.
2. In the Open box, type regedit, and then click OK.
3. Locate the appropriate registry subkey, right-click the IsInstalled
(REG_DWORD) value, and then click Modify. To reinstall only the
Internet Explorer 6 browser component on Windows XP, use the
following registry key:
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Active
Setup\Installed Components\{89820200-ECBD-11cf-8B8500AA005B4383}
To reinstall only Outlook Express 6 on Windows XP, use the
following registry key:
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Active
Setup\Installed Components\{44BBA840-CC51-11CF-AAFA00AA00B6015C}
4. Change the value data from 1 to 0, and then click OK.
5. Quit Registry Editor, and then download and install Internet Explorer 6.

How to Uninstall Internet Explorer 6?
Internet Explorer 6 is preinstalled by default in all versions of Windows
XP. To provide computer manufacturers greater flexibility in configuring
desktop versions of Windows XP, Microsoft has made it possible for OEMs
(Original Equipment Manufacturer), administrators, and users to remove
user access to Internet Explorer while leaving the Internet Explorer code
intact and fully functional to ensure the functionality of programs and
operating system functions that rely on it.
For example, Windows XP supports an "IEAccess=off" switch in the
Unattend.txt file, and Internet Explorer has been added to the
Add/Remove Windows Components section of the Add/Remove Programs
tool in Control Panel. However, this does not reinstall Internet Explorer.
Before you uninstall Internet Explorer 6, quit all running programs. After
you uninstall IE 6, you cannot uninstall the previous version of Internet
Explorer that remains on the computer. If you uninstall Internet Explorer
6, install any security updates that are needed for the version of Internet
Explorer that remains on the computer.
Use the following steps to uninstall Internet Explorer 6 from a computer
that is running Windows 98, Windows 98 Second Edition, Windows NT
4.0, Windows 2000, or Windows Me.
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1. Click Start, point to Settings, click Control Panel, and then doubleclick Add/Remove Programs.
2. On the Install/Uninstall tab, click Microsoft Internet Explorer 6
and Internet Tools in the list of installed programs, and then click
Add/Remove.
 Internet Explorer is not listed in the Add/Remove Programs tool if
you delete uninstall (or backup) information for the previous
version of Internet Explorer. In Windows 2000, installing a service
pack also removes Internet Explorer from the Add/Remove
Programs tool (but uninstalling the service pack restores Internet
Explorer to the Add/Remove Programs tool).
 If Microsoft Internet Explorer 6 and Internet Tools is missing
from the list of installed programs and you did not delete the
uninstall information or install (or reinstall) a Windows 2000
service pack, run Setup.exe from your Internet Explorer\Setup
folder. If you are running Windows 2000, run the w2kexcp.exe
/u command from your Internet Explorer\IE Uninstall folder. If
this does not work, you need to reinstall Windows.
 For Windows 98 and Windows Me, renaming the Iemigrat.dll
file and reinstalling Windows restores the version of Internet
Explorer that was included with that version of Windows. For
Windows 2000, reinstalling Windows restores the version of
Internet Explorer that was included with Windows 2000. For
Windows NT 4.0, and other versions of Windows if the above
procedures are not successful, reinstall your version of Windows
on an empty hard disk. Note that you should reapply any service
packs or other patches, updates, or hotfixes after you reinstall
Windows.
3. Click Restore the previous Windows configuration (or click
Advanced to specify any additional components you want to
remove), and then click OK.
4. The Internet Explorer 6 and Internet Tools Setup dialog box
appears. This portion of Setup is referred to as Maintenance mode.
When Setup starts, click OK to restore the previous version of
Internet Explorer and shared components.
5. You are prompted to verify that you want to restore the previous
version. Click Yes to start the uninstallation process. When the
uninstallation process finishes, click Restart Windows when you are
prompted.
Note: It is not necessary to remove Internet Explorer 6 before you
upgrade an operating system to Windows XP. However, if an
Internet Explorer Service Pack is installed, Internet Explorer 6 must
be reinstalled.

How to Repair\Return to Previous Installation?
If the Internet Explorer Repair Tool Verification does not work, or if
Internet Explorer 5 is not listed in the Add/Remove Programs tool in
Control Panel, you may be able to start the Internet Explorer Repair tool
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from a command prompt. To do so, click Start, click Run, and then in the
Open box, type the following command (exactly the same because this
command is case sensitive), and then click OK:
rundll32 setupwbv.dll,IE6Maintenance "C:\Program Files\Internet
Explorer\Setup\SETUP.EXE" /g "C:\WINDOWS\IE Uninstall Log.Txt"
If you need to replace a bad file from the original Internet Explorer or
Windows media, use either the System File Checker (SFC) tool or the
Extract tool to extract the file.

How to handle Error Message in IE6 Installation?
When you attempt to install Internet Explorer, you may receive the
following error message:
Windows Update Setup
A previous program installation was never completed. You need to restart
your computer to complete that installation before running Internet
Explorer Setup. Setup will now close.

Cause
This error message can occur if Windows was not restarted after installing
or updating files that were in use by Windows. For example, some
program installations or updates need to replace files that are currently in
use by Windows. Some files cannot be replaced while Windows is running.
Windows must be restarted so that these files can be updated during the
initial startup of Windows before they are loaded into memory. Internet
Explorer detects that these operations are pending and cannot be
installed until these operations have been completed.

Resolution
To resolve this issue, click OK, and then restart Windows. After Windows
has restarted, run Internet Explorer Setup again. If you receive the error
message again, click OK, and then restart Windows. After Windows has
restarted, run Internet Explorer Setup again.
Note: Restarting Windows may not resolve the issue. You may
need to perform the appropriate procedure below.

For Windows 95, Windows 98, and Windows Me Edition
Rename the Wininit.ini file, restart the computer, and then run Internet
Explorer Setup again. To rename the Wininit.ini file, follow these steps:
1. Exit Windows by clicking Start, clicking Shutdown, and then
clicking Restart in MS-DOS mode.
2. From DOS, run wininit.exe, and then press ENTER.
3. Type Exit and let Windows start backup.

If that does not work, then try the following steps.
1. Click Start, click Find (or Search), and then click Files or
Folders.
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2.
3.
4.
5.
6.
7.

In the Named box, type wininit.ini.
In the Look in box, click Local Hard Drives.
Click Find Now.
Right-click the Wininit.ini file, and then click Rename.
Type Wininit.nin, and then press ENTER.
Close the Find window.

For Windows NT 4.0 and Windows 2000
Warning: If you use Registry Editor incorrectly, you may cause
serious problems that may require you to reinstall your operating
system. Microsoft cannot guarantee that you can solve problems
that result from using Registry Editor incorrectly. Use Registry
Editor at your own risk.
Locate the following registry key and delete any…
PendingFileRenameOperations values in this key.
HKEY_LOCAL_MACHINE\System\CurrentControlSet\Control\Session
Manager
You may also need to check for and remove pending file rename
operations in the following registry keys:
HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\Curre
ntVersion\RunOnce
HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\Curre
ntVersion\RunOnceEx
HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\Curre
ntVersion\RunServicesOnce
HKEY_CURRENT_USER\Software\Microsoft\Windows\Curren
tVersion\RunOnce
Note: If the problem is still not resolved, check for the existence of
old installation files in your TEMP or TMP folders, check for the
existence of a folder named "$!$!$!$!" in the root folder, or try
emptying the Temporary Internet Files folder.

How to Delete Temporary Files
1. Double-click My Computer, double-click drive C, double-click the
Windows folder, and then double-click the Temp folder.
2. Press CTRL+A to select all the files in the folder.
3. Press the DELETE key.
4. Close My Computer.

How to Delete Temporary Internet Files
1. On the desktop, right-click Internet Explorer, and then click
Properties.
2. Under Temporary Internet Files, click Delete Files.
3. Click to select the Delete Offline Content check box, and then
click OK.
4. Close Internet properties.
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How to Install the XP Recovery Console?
The Recovery Console is a command line (similar to DOS) that provides a
long list of commands that you can use to troubleshoot/fix your computer
when your computer does not start properly or does not start at all. If you
can't get into safe mode, you should consider using the Recovery Console.
Installing the Recovery Console on your system takes up around 7MB of
disk space. To install the Recovery Console on your system follow these
steps:
1. Insert your Windows XP CD in the drive, and click 'Exit' when the
installation options are displayed
2. Click on the Start button and select Run
3. Type in 'C:\i386\winnt32.exe /cmdcons' and click OK
4. Follow the instructions to install the Recovery Console
5. When the installation is complete, restart your computer
The Recovery Console will show up in the list of available operating
systems in the boot menu. To use the Recovery Console, you will need
administrator privileges.

How to delete, largest Sys File (hiberfil) from your PC?
What is this huge file creep around on Windows XP computers, that is
really of no use and can you safely delete it? It happens to most users of
Windows XP. You are searching for a file or cleaning up the PC's hard
drive and you encounter a huge file - hiberfil.sys. Normally located at
C:\hiberfil.sys, its size can vary from 250MB to over 1GB. You try to
delete the file but Windows will not oblige anyway. Please note, it's not a
good idea to delete files you don't understand.
Windows XP has a feature that is not very well documented and it will be
totally new to users of older systems such as Windows 95 or 98. This new
feature is called Windows Hibernation. Instead of shutting down and
restarting your computer, Windows takes a snapshot of everything
running on your system, copies it to the hard drive and then turns off
most of your hardware. To wake up from hibernation you normally move
the mouse or hit the spacebar on the keyboard.
Hibernation temporarily 'freezes' the computer when the PC becomes
inactive, so it won't work if you have tasks running constantly. However,
it can be handy if you want the computer to sleep after a task has
completed.
Besides the role of hibernation, what is the hiberfil.sys file and why is it so
big? Hibernation takes everything in memory and writes it to your hard
drive as the hiberfil.sys file. If you have 512MB of memory, then
hiberfil.sys will be about 512MB. If you have 1GB, the file will be around
1GB. The important point to remember is that even if you don't use
hibernation, hiberfil.sys will still take up this huge amount of disk space.
The way to remove the file is to turn off the hibernation feature (by
default, hibernate is activated automatically when XP is installed). To
deactivate hibernation in windows XP, follow these steps:
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1. Open the Windows Control Panel.
2. Double-click Power Options
3. Click the Hibernate tab, de-select the 'Enable hibernate support'
check box, and then click Apply.
4. Restart your computer and hiberfil.sys will be automatically deleted.
5. To reactivate the hibernation, simply repeat the procedure and
select the 'Enable hibernate support' check box, and then click
Apply.

How to Increase Windows Folder Cache?
The default setting for Windows XP is to cache the Explorer settings for
400 folders. To increase it, follow these steps:
1. Start Regedit and go to
HKEY_CURRENT_USER\Software\Microsoft\Windows\ShellNoRoam
2. Change the value of BagMRU to whatever size you want (hex)
1000
2000
3000
4000
5000

-

3e8
7d0
bb8
fa0
1388

How to Increase Windows File System Cache?
To increase the amount of memory Windows will locked for I/O
operations, follow these steps:
1. Start Regedit and go to
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Session
Manager\Memory Management
2. Edit the key IoPageLockLimit
4096 - 32megs of memory or less
8192 - 32+ megs of memory
16384 - 64+ megs of memory
32768 - 128+ megs of memory
65536 - 256+ megs of memory

How to Configure for Auto-Logon?
If you are the only person using the computer and what to have it
automatically log you on,
1. Start>Run> control userpasswords2
2. Uncheck User must enter a user name and password to use
this computer

How to Poweroff at Shutdown?
If your computer does not turn off the power when doing a shutdown,
you may need to edit the registry. If you have all the correct BIOS and
Power settings and still needed to do this, follow these steps:
3. Start Regedit
3. Go to HKEY_CURRENT_USER\Control Panel\Desktop
4. Edit the key PowerOffActive and give it a value of 1
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5. You can do the same in HKEY_USERS\.DEFAULT\Control Panel\
Desktop

How to Show Hidden Devices in Device Manager?
You can show hidden devices in the Device Manager. One way is by
making a simple registry change. Here is how:
1. Go to HKEY_LOCAL_MACHINE \ SYSTEM \ ControlSet001 \ Control \
Session Manager \ Environment
2. Create a string DEVMGR_SHOW_NONPRESENT_DEVICES
3. Give it a value of 1

How to Add Safe Mode to the Boot Menu
You can add Safe Mode as an option to the normal XP boot screen. Here is
how you can do that:
1.
2.
3.
4.

5.
6.
7.
8.

9.

Open a command prompt
Copy the current c:\boot.ini to another name (just in case)
With your favorite text editor, edit c:\boot.ini
Copy then edit the current boot line to another line. For example:
multi(0)disk(0)rdisk(0)partition(1)\WINDOWS="Microsoft Windows
XP Professional" /fastdetect
might copy and then change to:
multi(0)disk(0)rdisk(0)partition(1)\WINDOWS="Microsoft Windows
XP Professional Safeboot" /fastdetect
Start MSCONFIG
Click on the BOOT.INI tab
Highlight the second line with the additional name of Safeboot
Check the /SAFEBOOT box with option you want
Minimal - Minimal set of drivers
Network - With Network Support
Dsrepair - Directory Services Repair
Minimal (Alternate Shell) - Standard Explorer Desktop
You will now have this option every time you start XP

How to set the Online Registration as being completed?
You can set WindowsXP to assume the online registration has been
completed. To do this, follow these steps:
1. Run Regedit
2. Go to HKEY_LOCAL_MACHINE \ SOFTWARE \ Microsoft \ Windows
NT \ CurrentVersion
3. Create a String Value called RegDone
4. Give it a value of 1

How to Re-enabling System Restore?
If you previously disabled system restore through the Group Policy Editor,
the option to start it again does not show in the System Properties.
You can re-enable it again by following these steps:
1. Run the Group Policy Editor (gpedit.msc)
2. Go to Computer Configuration / Administrative Templates /
System / System Restore
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3. Set Turn off System Restore and Turn off Configuration to
Disable
4. Right click on My Computer
5. Select Manage and go to Services and Applications / Services
6. Scroll down to System Restore Service and set it for Automatic
7. Click on the Start button to start the service
8. Close down this window
9. Go back to the Group Policy Editor and configure both to Not
configured
10. Now when you right click on My Computer, there should be a tab for
System Restore and you can configure how much space will be used.

How to Search for Key Words more effectively?
1. Put a plus (+) sign in front of each word and phrase. For example,
+write +wikihow +article
2. Wrap exact phrases in quotation marks. A search for +buy +"cat
litter" will get you better results than +buy +cat +litter.
3. If there's a word you DON'T want in your search results, put a
minus (-) sign in front of it.
4. Connect Words - Enter connected phrases with hyphens or quotes
as a single search-item, such as "baking German-chocolate-cake" or
"secret-revelation robe": connecting separate words can pinpoint
the search, whereas, putting many separate words would begin
matching millions of web pages containing only a few of all the
words (especially after more than 3 words/items are specified).
5. Connect Phrases - Use logical connectors or parentheses for more
complex searches such as: "blue-bird OR black-bird OR blackbird"
to match any of several similar items, and find a blackbird as one or
two words "black bird" etc.

How to keep spam out of the Inbox? (Step-By-Step)
Spam definition: A meat-like substance that tastes good but may clog
your arteries or a message-like substance from a complete stranger that
clogs your e-mail.
Let’s face Spamming. Even though no one likes receiving spam
(unsolicited commercial e-mail), deleting spam is still a part of almost any
Internet user’s daily routine. Unfortunately, the problem only seems to be
getting worse. Here we are discussing 5 fundamental rules that every email user must know and follow these instructions and precautions to
avoid spam.

Rule #1: Maintain two separate e-mail addresses
You should have one e-mail address that you give out only to close
friends and relatives—anyone with whom you would have personal
communication. Then establish another e-mail address with a provider
such as Hotmail or some other online account, and use that address every
time you fill out a form on the Web that asks for an e-mail address. Of
course, there’s no guarantee that your private e-mail address won’t get
out. If one of your friends or relatives includes you in a long cc list,
someone else in the cc list could disseminate your e-mail address.
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Rule #2: Don’t buy from a spam ad
This rule should be a given, but it’s important to underscore this point to
new Internet citizens. Spammers will only continue to spam as long as it
is profitable. By teaching your students to refuse to purchase any items
that are advertised in spam, then eventually it will no longer be profitable.

Rule #3. Don’t even respond to it!
Never, ever respond to a spam. Responding to spam, whether to a
“remove” address or otherwise will only worsen the problem. Responding
to spam only tells the spammer that your address is a valid e-mail
address that accepts spam. Don’t expect to get removed from any lists
that way.

Rule #4. Turn off cookies
Many of you will quarrel with this rule, because legitimate Web businesses
use cookie technology to save customers time and to serve them better.
But browser cookies have a dark side. Some unscrupulous businesses use
them to obtain information from you when you visit their Web site.
You can minimize the chances of your e-mail address being broadcast to
every Web site you visit by turning your browser cookies off, or at least
making your browser ask for confirmation before accepting cookies.

Rule #5: Report spam to your ISP
Most ISPs have strict anti-spam policies. Your students should report
spammers to their ISPs. In many cases, there is a good chance that the
account used by the spammer to get on the Internet will be disabled by
the ISP. As a last resort, you can fight spam with filtering software.
Personally, I am not a fan of filtering software. In many cases, it’s simply
too strict and winds up blocking personal e-mails that you really do want
to receive. However, all end users must know how to use an e-mail client,
and how to activate filtering and sender-blocking options—just in case
they need them.

How to Insert Automatic Product ID?
To create your own CD of Office2000/ OfficeXP so either version will
automatically fill in the product ID. Follow these steps:
1. Copy the source files to a directory on your hard drive
2. For either product, you need to modify the SETUP.INI file
3. In the [OPTIONS] section, add a line PIDKEY=XXXXXXXXX
(where the X's are replaced with product ID without dashes)
4. For Office2000 the Setup.ini file is on the root of the CD
5. For OfficeXP the Setup.ini file is in the Files\Setup directory

How to Burn your own CDs?
If you’re running Windows XP, then you don't have to go out and buy
expensive CD–recording software. The new operating system from
Microsoft features built–in CD burning. When you want to burn a CD using
Windows XP:
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1. Insert a blank CD–R or CD–RW in your CD drive. You must have a
CD–R (writable) or CD–RW (rewritable) drive. A dialog box opens,
asking if you want to open a writable CD folder. Click OK.
2. On the Start menu, click My Computer, and navigate to the drive
and folder where the files you wish to copy are stored.
3. Select the files you wish to copy, and drag/drop or copy/paste them
to the open CD recording folder.
4. In the left pane of CD folder window, click Write these files to CD.
Now you are all set. Just remember not to copy more files to the CD than
it will hold: a standard CD holds approx. 650 MB of data.

How to Backup your data?
Get Started
Before you can even think about creating a backup, you have to get your
files in order. Just check to make certain all your essential data files are
stored in one easy-to-find location.
Windows XP makes this task especially easy by giving every user account
its own personal profile, which consists of a set of subfolders in the
Documents and Settings folder. Your profile holds your personal files
(in the My Documents folder), Outlook Express e-mail messages, Internet
Explorer Favorites and cookies, and information about your settings and
preferences. If you have personal data stored elsewhere, consider moving
it into the My Documents folder to make backing up easier. If you're
unwilling or unable to move those files, make a note of where they're
located so you can be sure you add them to your backup set later.
Open Windows XP Backup
Windows XP includes its own backup program, although you may need to
do some digging to find it. You can also take your pick of third-party
programs (listed at the end of this column) that add bells and whistles
you won't find in the basic Windows XP Backup utility.
If you use Windows XP Professional, the Windows Backup utility
(Ntbackup.exe) should be ready for use. If you use Windows XP Home
Edition, you'll need to follow these steps to install the utility:
1. Insert your Windows XP CD into the drive and, if necessary, doubleclick the CD icon in My Computer.
2. On the Welcome to Microsoft Windows XP screen, click Perform
Additional Tasks.
3. Click Browse this CD.
4. In Windows Explorer, double-click the ValueAdd folder, then Msft,
and then Ntbackup.
5. Double-click Ntbackup.msi to install the Backup utility.
With that chore out of the way, you're ready to begin backing up. By
default, the Backup utility uses a wizard that makes the process
straightforward. To start Backup:
TIPS & TRICKS

WINDOWS XP HOW TOs

P a g e | 35

1. Click Start, point to All Programs, point to Accessories, point to
System Tools, and then click Backup to start the wizard.
2. Click Next to skip past the opening page, choose Back up files
and settings from the second page, and then click Next. You
should see the page shown in Figure 1, which represents your first
decision point.
Decide What to Back Up
You might be tempted to click All information on this computer so that
you can back up every bit of data on your computer. Think twice before
choosing this option, however. If you've installed a slew of software, your
backup could add up to many gigabytes. For most people, the My
documents and settings option is a better choice. This selection
preserves your data files (including e-mail messages and address books)
and the personal settings stored in the Windows Registry.
If several people use your computer—as might be the case on a shared
family PC—select Everyone's documents and settings. This option
backs up personal files and preferences for every user with an account on
the computer.
If you know that you have data files stored outside your profile, click Let
me choose what to back up. This option takes you to the Items to
Back Up.
Select the My Documents check box to back up all the files in your
personal profile, and then browse the My Computer hierarchy to select
the additional files you need to back up. If some of your files are on a
shared network drive, open the My Network Places folder and select
those folders.
This option also comes in handy if you have some files you don't want to
back up and want to keep your data file backup to a reasonable size.
Decide Where to Store Your Backup Files
On the Backup Type, Destination, and Name page, Windows asks you
to specify a backup location. By default, Backup proposes saving
everything to your floppy drive (drive A). Although that might have made
sense 10 years ago, it's hardly a rational choice today. You'd need
dozens, perhaps hundreds of floppy disks to store even a modest
collection of data files, especially if you collect digital music or photos.
Instead, your best bet is to click Browse and choose any of the following
locations:




Your computer's hard disk. The ideal backup location is a separate
partition from the one you're backing up. If your hard disk is
partitioned into drive C and drive D and your data is on drive C, you
can safely back up to drive D.
A Zip drive or other removable media. At 100–250MB per disk, this
is an option if you don't have multiple gigabytes to back up.
Unfortunately, the Windows Backup utility can't save files directly to
a CD-RW drive.
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A shared network drive. You're limited only by the amount of free
space on the network share.
An external hard disk drive. USB and IEEE 1394 or FireWire drives
have dropped in price lately. Consider getting a 40 GB or larger
drive and dedicating it for use as a backup device.

After you've chosen a backup location, enter a descriptive name for the
file, click Next to display the wizard's final page, as shown in Figure 3,
and then click Finish to begin backing up immediately.
Set a Schedule—and Stick to It
If you're disciplined enough, you can repeat the above steps once each
week and perform regular backups when you're ready. If you'd rather not
count on remembering to perform this crucial task, however, set up an
automatic backup schedule for Windows. When you get to the final page
of the Backup Wizard, don't click Finish. Instead, click the Advanced
button, and click Next to open the When to Back Up page. Choose
Later, and then click Set Schedule to open the Schedule Job dialog
box.
You can set almost any schedule you want by poking around in the
extensive set of options available in this dialog box. After you click OK to
save your changes, Windows XP runs the backup automatically. Just
remember to leave your computer turned on.
All in all, you can count on backing up 5 GB of data in as little as 10
minutes. And you don't need to worry about shutting down running
programs, either—thanks to a feature called volume shadow copy, the
Backup utility can safely create a copy of any file, even if it's currently in
use.

How to scan
The basic operation of your scanner, regardless of its make or model, can
probably be summarized in three easy steps. One, place the original on
the scanner. Two, open your scanning software and tell it to make the
scan, usually by clicking either File > Scan or File > Acquire (or, even
more simply, push the "Scan" button on the device itself). Three, save
the resulting image to your computer, so later you can print it, e-mail it,
or post it to the Web.
Getting the best scans, however, is not always so simple. Here are some
ways in which you can guarantee you get the best possible results from
your
scanner.
Resolution, bit-depth, and file format
Before you start to scan, think about how you plan to use the final
image.
a. Is it going to be used in printed material?
b. Will you perhaps print it out using your own photo-quality
printer?
TIPS & TRICKS

WINDOWS XP HOW TOs

P a g e | 37

c. Is the image intended for on-screen viewing only, perhaps
posted to a website or e-mailed to a friend or family member?
Depending on the final product, you will want to set your scanner to
capture the optimal image in terms of file size and picture quality. There
are three basic settings you can adjust in order to do this:
1. Resolution
Digital images are broken down and stored as pixels, dots of lights
with their color value stored as a series of zeroes and ones.
Resolution measures the number of pixels-per-inch (ppi), and thus
serves as a guideline for the details available in the final image.
Most scanners are capable of capturing an image in a grid pattern,
300 ppi wide by 300 ppi deep. This gives you a very high quality,
detailed image. But most image output devices (printers and
monitors) are not capable of utilizing such fine detail. Average
monitors, for example, only display at a resolution in the range of
72 to 96 ppi. Making a high-resolution scan of an image that will
only appear on screen will result in an unnecessarily large file size.
However, if you are planning to print your image on a high quality
printer, you will not be satisfied with the outcome if you made your
scan with a lower resolution.
2. Bit-depth
Bit-depth refers to the number of colors that the scanner will
capture. A 1-bit scan will capture only black and white, a 4-bit scan
will capture 16 colors, and an 8-bit scan will capture 256 colors.
With a 16-bit scan, you will get over 65,000 colors, while a 24-bit
scanner will capture 16.8 million colors. The higher the bit depth,
the better the color, but only at the expense of file-size. For online
viewing, an 8-bit scan will be more than sufficient, but for color
printing bump the scan up to the highest bit-depth available for
your scanner.
3. File format
The format in which you save your scanned image will be the final
crucial choice you have to make. The two most common formats
for image files are TIFF and JPEG. TIFF uses a lossless compression
process, which means that you will have no loss of detail in the
image. You should use the TIFF format when you plan to print your
image. JPEG, on the other hand, should be used if you are going to
put your image on the Web or send it via e-mail. While some detail
is lost in the compression process, it will not be noticeable when
viewed on screen, and it provides a compact file size for speedy
downloading.

Best scan tips


Choose the best photo. While you can punch up color and fix some
fuzziness with image editing programs, the better your original
image, the better your final scan will be. Choose pictures that have
good
lighting
and
contrast
to
get
the
best
results.
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Scan your photo in the orientation, in which the image will be used.
Some detail is lost when you rotate the image in your desktop
publishing or image-editing program.



Scan only what you need. Do not scan a whole image if all you
need is a small portion. Your scanner software has tools to preview
and select only the portion of the original that you
want.



Use your image editor, not your scanner software, to adjust color
and sharpness of your scanned image.



Know your scanner software. If a manual is available, read it from
cover to cover to know how to get the most from your particular
software. Otherwise, spend time playing with the program until you
get the hang of it.



Practice, practice, practice. The more scans you make, the better
you will understand how to get the best images from your scanner.

How to choose a digital camera?
1- Resolution:
When determining a digital camera’s image quality is its resolution. A
camera's resolution is determined by pixels: the more pixels, the higher
the resolution. And the higher the resolution of a digital photo, the more
you can enlarge it without losing image resolution. You shouldn’t settle for
less than 2 megapixels if you’re planning to enlarge pictures.
2- Built-in memory:
Choose a camera that has “built-in” memory and a card slot for external
memory card.
3- Battery life:
Digital cameras go through batteries extremely fast, which obviously can
be very expensive. Look for a camera that accepts rechargeable batteries.
Another way to save battery power is to get a camera that has an AC
adapter, and then you can power the camera from a wall socket.
4- Computer compatibility:
Make sure that the camera you buy is compatible with your computer
system, and particularly check your connection ports (serial, USB, IR).
5- The LCD lowdown:
Most digital cameras come with an LCD screen built into the back, which
you can use as a viewfinder. The LCD screen let’s you see what your
picture will look like before you take it. Of indispensable help, it also
allows you to look at the photos you've already taken. But it is also a
major battery consumer, so if you use it often, have extra batteries on
hand or use an AC adapter.
6- Special features:
If you want to take close-ups of distant objects, for example, then you'll
need a camera with high optical zoom power. If you were going to take
action shots of sports or nature, then a camera with a continuous
shooting and landscape modes would be helpful.  
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